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1.0
Introduction

This document provides a description for the use of the Orbital Display System (ODS) version 7. ODS was developed under contract to the National Oceanic and Atmospheric Administration (NOAA), National Environmental Satellite, Data and Information Service (NESDIS), Center For Satellite Applications And Research (STAR).

ODS was originally developed to support the display of soundings and sounding related grid files. Original versions only supported a single grid resolution (2.5 by 2.5 degrees). Later versions supported multiple grid resolutions as well as sequential data. All versions of ODS prior to version 6.0 ran on the DOS operating system only. Beginning with version 6.0, ODS became capable of running on a large number of operating systems using Java.

Beginning with version 6.4, the name of the program was changed from the Environmental Data Graphical Evaluation Imaging System (EDGEIS) to the Orbital Display System (ODS).

1.1
Capabilities

The primary purpose of ODS is to display images that show horizontal cross-sections of the Earth’s atmosphere using data from a variety of sources including weather satellites and forecast models. The layout of the program was designed with this in mind and most program functions use horizontal images as a starting point. ODS provides a variety of functions that are used to generate and manage horizontal images.

Several utilities are available which allow images to be analyzed. One such utility is the ability to generate an image that shows the difference between two horizontal images. This is a useful tool that makes it easy to compare data from different systems. Other utilities that can be use to analyze data include a blinking function that will blink data that matches a specific value or a range of values.

ODS provides the ability to take a closer look at the data used to create horizontal images. Any location on an image can be selected to obtain additional data associated with the location. When this is done, a graph of all available profiles is displayed along with other raw data associated with the selected location.

In addition to horizontal cross-sections of the Earth’s atmosphere, it is possible to display vertical cross-sections of the atmosphere. These cross-sections can cut though the atmosphere between any two points on the Earth. When this is done, the vertical cross-sections will show any available profile data.

1.2
New Features In Version 7
Version 7.0 introduced a significant number of changes to ODS:

New file format: An entirely new file format was created for use with the ODS. The new format, described in detail in section XXX, provides greater flexibility for various satellite systems as well as significantly reduced disk space.
Multiple data sets: The new file format includes support for the inclusion of data sets within a single ODS file. When using the previous file format, if it was desired to see data from two different days it was necessary to create two separate files. But with the new format, data from each day can be stored in separate data sets within the same file. This is also useful when viewing GOES data where data for each one hour period can be stored in one file instead of being separated into 24 individual files.
New user interface: The data selection dialog has been updated to provide a better way to select which data to display and how to display the data. The dialog has been split into sections, each of which can be accessed by clicking on an appropriate tab.
Data filtering options: Prior versions of the ODS contained a set of data filtering options that were used for every file regardless of the source of the data. ODS7 introduces the ability to use filtering options that can be unique to data contained within a specific file. For example, some satellite systems divide orbital node data into ascending and descending. But one systems divides the data into ascending, descending, north pole and south pole. Older versions would force the north pole and south pole values into either ascending or descending before data filter could be done.
Profile and cross-section display: Older versions of the ODS were able to display temperature and moisture profile data from every available satellite system. But the profiles were not always displayed well. ODS 7 improves the display of profile data from all satellites.
Multiple monitor support: ODS 7 provides better support for multiple monitors. When windows are moved between screens that are at different resolutions, the program automatically adjusts. Also, dialogs are displayed on the same screen as the main window.
Enhanced math functions: The math function code in ODS has been completely rewritten to increase the flexibility and to make it easier to modify the images created by the math functions. The data selection dialog was improved to make it easier to modify the math functions.
Crosshairs and pixel values: ODS 7 adds the ability to display a crosshair that is centered where the mouse pointer is located. When displaying a data frame that contains more than one image, each image has the crosshair display in the same location, which makes it easier to compare data between multiple images. Another added feature is the ability to display the location and data value that corresponds to the position of the mouse pointer.
2.0
Installing ODS
The Orbital Display System is a Java program. The program can be run on any operating system that has Java installed. ODS 7 requires the use of Java 1.5 or greater. Most users should not need to be concerned about the version of Java since all version of Java released since 2005 should work.
Installing ODS is a simple as copying the main program, ODS.jar, to any folder on a computer. The actual location does not matter, but it is advisable to place it within its own folder. When the program is run for the first time, it will create a subfolder called “edgedir” into which it will store data frame information and other user settings.

When a new version of ODS is available, the older ODS.jar file can be replaced with the new version.
2.1
System Requirements

ODS will run on any computer that is capable of running Java programs. This includes, but is not limited to, all versions of Windows, Mac OS X, Linux and most versions of Unix.

There are no specific requirements concerning the amount of disk space that must be available. The program itself takes approximately 2 megabytes of space. The number of frames that are available will increase the amount of space used. Each frame will use between 500 and 1000 kilobytes. This amount is small enough that most users will not need to be concerned about disk space. The memory footprint used by ODS will vary depending on the size of the main window. In most cases the program will require approximately 50 megabytes of memory.
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2.3
Running The Program

There are two methods available for running ODS. The first method is to go to the command line, switch to the directory that contains ODS.jar, and type the command:


java –jar ODS.jar

The second way to run ODS will usually be the easiest. On most operating systems all you need to do is double-click the ODS.jar icon just like you would if you were running any other program. This will kick off Java and start running the program.

2.4
Default Directories

ODS uses a default directory structure to store various files that may be needed and to store temporary frames. This directory will be named “edgedir” and will be located in the same directory as the ODS.jar file. If the directory does not exist when ODS is run, it will be created automatically.

The edgedir directory will contain the following files and  directories:

saved_state.edg
This file contains information about the state of the program at the time that it was last run, including a list of available frames. If this file exists, it will be read and the previous state of the program will be restored.

color_scales
This directory contains custom color ramps. Any custom color ramp in this directory will be available within ODS and may be applied to any image.

frames
This directory can be used to store saved frames. Saved frames can be saved in any location, but this directory is included as a convenience.

images
This directory can be used to store saved images. Like the frames directory, images do not have to be stored in this directory.

temp
Temporary frames are placed in this directory by the program.

3.0
Using ODS: Horizontal Images
ODS has been designed to function just like most window-based programs. The main window will typically appear similar to Figure 1. All of the program functions can be accessed from the menus at the top of the window. The bottom of the window contains controls that are used to change frames and switch between frames.
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Figure 1 — The typical layout of the main window. 
The actual look of the window may vary depending on the operating system
The main part of the window contains one or more images arranged in a grid. Information about the images is shown at the top of each image. Underneath each image is a color scale that shows which values are represented by the various colors.

Below the images is an area of the window that contains frame management (section 3.1) controls. On the right side are controls that can be used to switch from one data frame to another. Two buttons are on the left side. One button adds a new frame to the window while the other button brings up the data selection dialog.
On the left side of the main window is a toolbar. All program functions in the toolbar are also available from the menus. But the toolbar provides quick access to frequently used functions. The icons in the toolbar perform the following functions:
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	New Frame. Creates a new frame and inserts it immediately after the current frame.
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	Open Frame. Opens a frame from a file and inserts the frame immediately after the current frame.
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	Close Frame. Removes the current frame.
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	Save Frame. Saves the current frame to a file. If the frame has been previously saved, it will be resaved to the same file. If the frame has not been saved, a dialog will appear into which the name of the frame can be entered.
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	The arrow icon returns the program to its default state. When other functions, such as zooming, are done the program will remain in that state. This will turn the other function off.
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	Used to toggle the display of crosshairs on each image.
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	Toggles the display of data values near the cursor as the mouse pointer is moved over an image.
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	This icon turns on the “zoom in” function. After clicking this button the cursor will turn into a magnifying glass with a plus sign.
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	This icon turns on the “zoom out” function. Clicking this button will cause the cursor to change to a magnifying glass with a minus sign.
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	When this icon is clicked, the zooming will be turned off and the image will be redrawn showing the full data coverage (usually the full Earth).
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	Clicking this icon will turn on the profile selection function. After it is clicked the cursor will change to a hand with a profile graph on top of it.
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	This is the vertical slice icon. After it is clicked the cursor will change to a hand with a slice image on top of it. It will then be possible to create a vertical cross-section.
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	After this icon is selected, it will be possible to draw a line across the image. Next to the line will be a box containing the distance between the start of the line and the end of the line.
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	This toolbar icon turns blinking on or off. If there is no blinking happening when this is clicked, a dialog will appear that provides the ability to blink a range of data. If this is clicked when blinking is occurring then the blinking will stop.
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	This icon provides a quick way to access the image differencing function. Once clicked it will be possible to selected two images to difference and a place to put the resulting image.
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	This icon can be clicked to refresh all of the images in the current frame. After it is clicked each image will be recreated. This will usually be done to recreate the image in order to pick up any new data that may have become available since the last time the image was created. It may also be used to redraw the images after the size of the main window has been changed.


3.1
Frame Management

The Orbital Display System is designed around the concept of a frame. A frame is an object that holds one or more horizontal images. With ODS it is possible to switch between frames as well as add, delete, save and open frames. This allows for the creation of new images while older images can be kept around for later viewing.

Information and data associated with each frame are stored in a frame file. In most cases, the typical user will not need to be concerned about the actual name and location of the frame files. The following information is provided, however, because it may occasionally prove useful to understand the method used by ODS to manage the frames.

When a new frame is created it is initially stored in a file in the /edgedir/temp directory. The file name that the frame is stored under uses the form: default_window_yyjjjsssss.frm, where yy is the two digit year, jjj is the julian date, and sssss is the second of the day.

Using such a naming convention for each frame assures that each temporary frame has a unique file name. It also indicates when a given frame was created, which could help in identifying frames.
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The file that the frames are stored in remains in the Temp directory until it is closed or the frame is saved under a different name. When ODS is exited, it first checks the files in the Temp directory and removes all files that are no longer associated with current frames. This prevents a buildup of unused frames in the Temp directory.

3.1.1
Adding New Frames

A new frame can be added at any time by selecting “New” from the File menu or by clicking the “New Frame” button at the bottom of the main window. A dialog will appear (Figure 2) which shows 9 panels, one of which will be blue. This dialog will allow you to choose the number and layout of images within the frame. 
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Figure 2 — New Frame Dialog
Each frame may contain 1 to 9 images. The layout of the images can be selected by clicking or dragging the mouse anywhere within the boxes in the dialog. As this is done, the various boxes will change between gray and blue. The blue boxes show the current number of images and their layout.

In addition to the 9 boxes, the dialog also contains a text field that allows you to enter a description of the frame. It is not necessary to enter a description (“Untitled” will be used as a default). But adding a description can prove useful when attempting to locate a particular frame among many open frames. If a description is not provided here, it can be changed from within the frame itself at a later time.

3.1.2
Opening A Saved Frame

Frames that have been saved can be reloaded by selecting “Open” from the File menu. An open file dialog will be displayed from which the name of a saved frame can be selected. After a frame file is selected, it will be opened and inserted immediately after the current frame. The newly opened frame will then become the current frame.

3.1.3
Saving A Frame

The current frame can be saved at any time by selecting either “Save” or “Save As” from the File menu. If the frame has not been saved under a different name (i.e, it still uses the e6fmmddyyyhhmmss.frm naming convention), then “Save” and “Save As” will both cause a save file dialog to appear. This dialog can be used to select a directory and file name to save the frame under. By default the Frame directory is initially chosen as the directory to save the frame in. The frame may be saved in this directory or any other directory.

If the current frame has been saved previously, then choosing “Save” will automatically save the frame without displaying a save file dialog. The frame is saved using the previously selected file name.

3.1.4
Removing A Frame

When “Close” is selected from the File menu, the current frame is removed from the list of available frames. If the frame has not been previously saved (i.e., it still uses the e6fmmddyyyyhhmmss.frm naming convention), then a dialog will appear that asks whether or not the frame should be saved before it is removed. If “Yes” is selected, a save file dialog will appear which allows the frame to be saved under a new name. If “No” is selected, the file is removed from the list of available frames and will be permanently deleted. If “Cancel” is selected then the frame is not removed.

3.1.5
Copying Frames

There are occasions when it is useful to make a copy of a frame in order to use the frame’s settings in another frame without the need to re-enter all of the settings manually. ODS provides two methods for doing this. When a frame is copied, the copy is initially identical to the original frame in every way except for its location within the list of available frames.

Located under the File menu are two commands: “Copy Frame” and “Copy Frame To”. The “Copy Frame” command will create a copy of the current frame and will insert the copy immediately after the current frame. The “Copy Frame To” command also makes a copy of the current frame. Before the frame is copied, however, a dialog containing a list of frames (excluding the current frame) will be displayed. After a frame is selected from the list, the current frame will be copied. Unlike the first copy command, the new frame will not be placed after the current frame. Instead, the frame that was selected in the dialog will be replaced with the copy.

3.1.6
Switching Between Frames

When ODS contains more than one frame it is possible to switch between all of the available frames. The switching can be done using several methods:

Left/Right arrow buttons
Using the mouse, the left and right arrow buttons can be used to switch frames. These buttons are located near the lower right corner of the main window. The left arrow button causes the frame that precedes the current frame in the list of available frames to be displayed. The right arrow button causes the succeeding frame to be displayed.

Left/Right arrow keys
The left and right arrow keys on the keyboard can also be used to switch frames. They function in the same manner as the left and right arrow buttons.

Page Up and Page Down
These keys on the keyboard can also be used to switch frames. The Page Up key selects the frame after the current frame. The Page Down key selects the frame before the current frame.

Entering the frame number
Near the lower right corner of the main window is a text area that contains the current frame number. By entering a different frame number in the text area and hitting the Enter key, the frame matching the entered number becomes the current frame.

Using the drop down list
To the left of the arrow buttons is a drop down list that contains the descriptions for every available frame. A specific frame can be chosen by selecting it from this list.
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Figure 3 — Data Frame Controls.

The left / right arrow keys and page up  / page down keys can also be used.
3.2
Creating And Modifying Horizontal Images

Horizontal images are created and modified using the data selection dialog (Figure 4). To bring up the dialog, you can press the “Select Data” button at the bottom of the main window or press the F4 key. The dialog contains a collection of controls for each panel in the current frame.
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Figure 4 — Data Selection Dialog
The data selection dialog in figure 4 shows the data selection options when the data frame contains a single image. If the data frame contains more than one image, then the right side of the dialog will contain controls for each panel arranged in the same grid as the images in the data frame.
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The data selection tabs along the left side are used to switch between available controls. The data selection controls are grouped into the following categories:
Data Source:
Controls that are used to choose what data to display. This tab contains the file selection button, the list of available parameters, data filtering controls and math function controls.

Display:
Contains controls that are used to choose how to display the data. Within this tab are controls for projection, smoothing, contouring and color scale selection.
Coastline:
The display of coastlines and geopolitical boundaries is modified using controls within this tab.
Grid Lines:
Controls for the display of grid lines are contained within this tab.

Image Titles:
This tab contains controls that are used to replace default image titles with custom title strings.

Background:
The background color for images can be changed using controls that are contained within this tab. Also within this tab are controls that can be used to insert a picture as part of the background.
3.2.1
Data Selection:  Data Source
A typical layout for the data source tab within the data selection dialog is shown in Figure 4. At the top of the window are tabs that are used when working with math functions. The “Close Panel” and “Reset Panel” buttons are also used with math functions. These controls will be discussed in detail in section XXX.
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Below the math function controls is an area that is labeled as “Data Source”. When clicked, the select file button will bring up a file selection dialog from which a file can be selected. If a file has been selected the name of the file is displayed next to the button.
The data set selection drop-down list is beneath the select file button. If the selected file contains more than one data set, the list can be used to select one of them. The data set control will be greyed if the file only contains one data set.
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At the bottom of the data source area is a drop-down list that contains all of the visible parameters that are available in the selected file.
Below the data source area is an area that is labeled “Data Filtering”. The controls in this area will change depending on the selected file. Each ODS file contains information that is used to allow some of the data to be filtered. The specific filters can be unique to each file.
[image: image54.emf]
In the image to the left, the selected file contains filters for orbital node, quality control and date range.
The orbital node filter allows data to be removed from the image depending on whether the checkboxes are selected. In this example, each checkbox is selected so no data will be filtered based on the orbital node. To filter all data that have ascending orbital node values, the descending box should be unchecked.

The quality control filter in the example is from a system that has quality control flags for infrared, microwave, iNOAA, MIT and NOAA reg. If one or more of the checkboxes is not selected, then data with quality controls flags that match the unchecked box will be removed from the resulting image.
The date range controls are used to reduce filter any data that falls outside of the selected date range.
[image: image55.emf]
At the bottom of the data source tab is an area labeled “Data Range and Masking”.
By default, when displaying data in ODS the range of the data scale will be set to automatic which will result in the range being set to the minimum and maximum values that are used when creating the image. When the manual radio button is selected, the values that are entered into the minimum and maximum text fields will be used as the data range limits.
The data mask controls can be used to mask any data to either prevent the data from being displayed or to display the data in a chosen color. A data mask is created by entering a low value and a high value into the “from” and “to” text fields on the first line. A second range of values can be created by entering values on the second line.
If the “ignore masked data” button is selected, then any data values that fall within the data ranges will not be displayed. If the “replace with color” button is selected that data values that fall within the data range will be displayed using the chosen color. The color to use can be changed by selecting the “Pick Color” button which will bring up a color picker dialog.

3.2.2
Data Selection:  Display

The display tab within the data selection dialog is shown in Figure 5. Projection related controls are at the top. A thumbnail of each available projection is displayed next to radio buttons that are used to select one of them. Controls on the right side are used to adjust the projection including the latitude and longitude at which the projection will be centered, the hemisphere (for the polar projection) and the amount of zooming. More information about each projection is contained in Apendix XXX.
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Figure 5 — Display tab in the data selection dialog
The smoothing and contouring area contains the controls that control smoothing and the number of colors used when displaying images. When the smoothing slider is set to a value between 1 and 25, the data in the image will be smoothed by the pixel averaging or fill only method.
When the pixel averaging is selected, the value at every pixel in the image will be the average of all pixels that are within a radius of N number of pixels where N is the amount of smoothing. The fill only option does the same thing except it will only perform the averaging for pixels that do not already contain data. Pixels that contain data will keep their original values.

The contour text field accepts values from 2 to 240. The number entered will be the number of colors used when displaying the data. When the value of the number is lowered, the resulting image will contain a contoured effect. This is especially true when combined with smoothing.
Figure 6 shows an example of smoothing and contouring combined. The image on the left shows data that has smoothing set to 0 and the number of colors set to 240. The image on the right shows the result of changing the smoothing to 15 and reducing the number of colors to 10. The gaps in the data are filled in by the smoothing and the reduction in the number of colors has created a contour effect. In this example, the type of smoothing was set to pixel averaging.
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Figure 6 — Smoothing and Contouring
At the bottom of the display tab is an area that contains a drop-down list that can be used to select the color scale. When the list is set to the default scale, then the scale that is used will be determined by settings within the ODS file. The color scale can be changed by selecting any of the scales in the list:
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3.2.3
Data Selection:  Coastline

The coastline tab in the data selection dialog (figure 7) controls the display of coastlines and geopolitical boundaries. The coastlines represent continental outlines. The geopolitical boundaries show the outlines of countries and states.
The default settings for the controls is to display the coastlines while only displaying the geopolitical boundaries when zooming. The default colors are obtain from the chosen color scale.
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Figure 7 — Coastline and Geopolitical Boundary Options
The coastline controls are located in the top half of the coastline tab while the geopolitical controls are in the bottom half. The controls for both are the same with the exception of the boundary display buttons. For coastline, the display option can be set to yes or no. For the geopolitical boundaries, the option can be set to yes, no or zooming only. When set to yes, the boundaries will always be displayed. Selecting no will result in the boundaries no being displayed. When the zooming only option is set, the geopolitical boundaries will not be display when the entire Earth is showing (no zooming) but will be displayed when zooming is being done.
The colors for both the coastline and geopolitical boundaries default to colors specified in the chosen color scale. The colors can be overridden by selecting a color by clicking on the “Pick Color” button.
The thickness of the lines can be adjusted by selecting or unselecting the “Auto Adjust” box and by picking a thickness value using the slider. When the auto adjust box is selected, the thickness of the coastline will be automatically set to a size that is appropriate based on the size of the image. When the auto adjust box is not selected, the thickness of the line will be based on the slider value.

3.2.4
Data Selection:  Grid Lines

The grid line tab (figure 8) contains controls that affect the display of grid lines that can be plotted on top of images. The color of the grid lines can be set to the default color, which is defined by chosen color scale, or a custom color. The thickness and line style can also be selected. The spacing, in degrees, between each grid line can be changed by entering values into the longitude and latitude text boxes.

The option of showing just grid lines or also displaying the latitude and longitude values is set by selecting the yes or no button on the “Show Lats/Lons” line. When yes is selected, the value will appear on top of each line. The color used when display the numbers can also be specified.
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Figure 8 — Grid Line Options
3.2.5
Data Selection:  Image Titles
The title strings above each image are created by default from the name of the system, the selected parameter and the date of the data. These values can be replaced by custom string by selecting controls in the Image Titles tab (figure 9).
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Figure 9 — Image Title Options
The top of the tab shows the default strings that will be displayed based on the current selections. In the custom titles area, any custom titles will appear in the “Current Custom Titles” area.

New custom title strings are set by first picking the number of rows and columns. The numbers can range from 1 to 3. The titles will be arranged in a grid based on the number of rows and columns. When the numbers are changed, the area underneath will change to create text fields and alignment buttons for each string.

The new strings can be entered in the text fields. There is not a limit to the number of characters for each string but it is a good idea to keep the strings short. The program will adjust the font size in an attempt to fit all of the strings within the available space.
Beneath the text fields are buttons corresponding to each field which control the alignment of the text.
3.2.6
Data Selection:  Background

The background tab in the data selection dialog (figure 10) contains controls that alter the background of images.
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Figure 10 — Image Background Options
The default background color for all images is black. A custom color can be chosen by clicking the “Selected Color” button and then clicking the “Pick Color” button which will bring up a color picker dialog.
A second option for the background of ODS images is the ability to insert a picture as the background. Clicking on the “Select Image” button will bring up a file dialog from which an image file can be selected. The image will be plotted in the background of the ODS image using the left longitude, right longitude, top latitude and bottom latitude values that are entered into the text fields.
3.3
Zooming In and Out

Zooming, both in and out, can be applied to any horizontal image. Zooming is turned on by selecting the appropriate menu item under the Tools menu or by clicking the appropriate icon in the toolbar. After zooming is turned on the cursor will change to a magnifying glass with either a plus sign or a minus sign, depending on the zooming direction. At this point, any location on the image can be clicked on and zooming will occur at the selected position.

When zooming in, the zoom amount will be increased by a factor of 2. After the image is rebuilt, zooming can be performed again and the zoom amount will again be increased by a factor of 2.

Zooming out behaves in the same manner as zooming in, except that the zoom amount is decreased by a factor a 2 each time it is done. If it is no longer possible to zoom out any further, zooming out can still be done but will not have any effect on the zoom factor. It will, however, have an effect on the image. Because the map is centered on the selected location after each zoom, zooming out when the entire Earth is visible will essentially re-center the map on the selected location.

Clicking on the Earth icon in the toolbar will reset the zooming to show the entire Earth centered on zero degrees longitude and zero degrees latitude. Pressing the Shift key while doing any zooming will apply the zooming to all images in a data frame.

3.4
Data Values Tool

When the data value tool is selected in either the toolbar or from the Tools menu, the latitude, longitude and data value at the cursor position will appear in a box next to the cursor. In figure 11, the latitude and longitude of the cursor position is displayed on the top line. The data value at the cursor position is displayed on the second line. As the cursor is moved over the image, the values update. If more than one image is showing in the data frame, the values will appear on each image.
[image: image27.png][ ] Orbital Display System - Version 7.12
File Edit Frame Tools Help

Dée ECMIWE Analysis Augustl, 201502

Ed
;ﬂ | New Frame | | Select Data ) 5: 5: ECMWF B 5 out of 7





Figure 11 — The Data Value Tool

As the cursor moves over the image, the latitude/longitude and data value appear next to the cursor
3.5
Crosshair Tool

The crosshair tool, accessible from the toolbar and from the menu bar, makes it easier to identify matching locations when more than one image is showing in a frame. When the crosshair option is turned on, a large crosshair appears on top of the image. The crosshair will follow the location of the cursor. If the current frame contains more than one image, identical crosshairs will appear on top of each image and will be centered at the same location.
Figure 12 shows an example of the crosshair tool. In this example, the cursor is located in the lower left image. Each image has a crosshair on top of it with the crosshair centered at the same relative cursor location. This makes is easier to determine which locations in each image correspond to each other.
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Figure 12 — Using the crosshair tool

The crosshair in each quadrant matches the location of the cursor in the lower left
3.6
Blinking

Two types of blinking can be applied to images within ODS. One type of blinking is to have individual data values blink. The other type of blinking is to have a range of data blink. If either of the two types of blinking is done, the pixels that represent blinking values will alternate between the background color and the original pixel color.

The blinking will continue indefinitely until it is turned off. Because blinking is designed as a toggled function, it is either on or off. The first time that blinking is selected it will be turned on. The next time that it is selected, blinking will be turned off. The third time it is selected it will be turned on again, and so on. Blinking can be turned on and off in three ways:

1. Choosing “Select Blinking Data Range” from the Tools menu,

2. Clicking the blinking icon in the toolbar, or

3. Pressing command-b.

3.6.1
Blinking A Range Of Data

When blinking is turned on, a dialog will appear that contains one panel for each panel in the current data frame (Figure 13). The top of each panel contains three radio buttons. If “Blink the selected data” is selected, then all data that lies between the “from” value and the “to” value will blink. If “Blink the non-selected data” is selected, then all data that is less than the “from” value and greater than the “to” value will blink. When “Don’t blink the data” is selected none of the data will blink. This will normally be done when the current frame has more than one panel and it is not desirable to blink the image in one of the panels.
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Figure 13 — Data Blinking Dialog
Beneath the radio buttons are controls that are used to select the range of data to blink. The “from” and “to” fields will initially contain the minimum and maximum data values from the image. If the image had been set to blink previously, these fields will contain the most recent blinking range. If the image contains special data, such as clear values, then a checkbox will be present for each special value. After any special values are two checkboxes for out of range data.

At the bottom of the panel is a slider that can be used to adjust the rate of blinking. The blinking rate can range from 0.1 seconds (fast) to 10 seconds (slow).

3.6.2
Blinking Selected Values

Individual data values can be set to blink by double-clicking on the color scale beneath the image. The value that is clicked on will become the blinking value. The image will continue to blink until blinking is turned off.

While an individual value is blinking it is possible to switch to another value without having to turn the blinking off first. One way to do this is to double-click on another value in the color scale. A second way is to press either the “<” key or the “>” key. When the “<” key is pressed, the next blinking value will be the value that immediately precedes the current value. Likewise, the “>” key will set the next blinking value to be the value that succeeds the current value.

3.7
Distance Tool

The distance tool is used to determine the distance between to points on an image. When the option is turned on, it becomes possible to draw a line across an image by clicking at a starting point and, with the mouse button still pressed, moving the cursor across the image. As this is done, a line will appear on top of the image (figure 14). Next to the cursor will be a box that contains the distance from the start of the line to the end of the line. When the mouse button is released the line will go away.
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Figure 14 — Distance Tool

When a line is drawn across the image, the distance from the start of the line to the end is displayed
3.8
Color Ramps

Every parameter displayed by ODS uses a color ramp to define which colors are used to represent the data. The color ramp used for a particular parameter is set in the file that the data is read from and is used by default. But the default ramp can be replaced by certain pre-defined ramps, such as grayscale, or by custom color ramps created by the user.

One of the options contained in the data selection dialog is a control for the color scale. This list contains an option for the default scale and two grayscale options. It also may contain user-created custom color ramps. The custom ramps, if available, will appear at the end of the list. Custom ramps will appear in the list if they are located in the “/edgedir/color scales” directory.

A custom color ramp can be created at any time by right-clicking on the image and choosing “Modify Color Ramp” from the pop-up menu. Doing this will create a dialog that provides the ability to change any of the colors in the current ramp (Figure 15).
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Figure 15 ‑ Color Ramp Dialog
The 256 rectangles on the right side of the dialog show the current colors for each of the 256 indices of the color ramp.  The color rectangles along the bottom row represent the 10 special values, the out of bounds low and high colors, the coastline color, and the background and foreground colors.

Any one of these can be changed by clicking on the rectangle. When a rectangle is chosen, the index value underneath it will turn white. A new color can then be chosen using one of several options. The first option for picking a color is to click or drag the mouse on the round color wheel. As the mouse is clicked or drag, the color in the chosen rectangle will change to reflect the new color. As the color changes, you will notice that the sliders underneath the color wheel move. These sliders are another way to pick the color. The top three sliders represent the red, green and blue components of the color. The bottom three sliders represent hue, saturation and brightness. A third way to pick the color is to enter appropriate values in the text fields next to the sliders.

Because most color ramps use colors that gradually change, such as yellow to orange to red, an option is available to automatically calculate the colors between to colors. To do this, click on the “Fill” button. This will change the cursor to a hand with “From” on it. Next, click on the color rectangle that you want to start from. Once this is done the cursor will change to “To”. At this point, click on the color rectangle that you want to end at. When this is done, all of the rectangles between the two chosen colors will fill with colors that change smoothly between the two selected colors.

When using the fill option, it is important to understand the direction in which the fill is done. On the round color wheel, there is a line going from the center to the right side of the wheel. This line shows the division between the colors. As an example, assume that the fill function is being done between purple (at 2 o’clock on the color wheel) and orange (at 4 o’clock). When the fill is done, the colors in between these two colors will not change from purple to red to orange. Instead, the colors will change from purple to blue to cyan to green to yellow to orange. This is because the direction of the fill never crosses the dividing line.

The name of the color ramp can be changed by entering a new name in the color ramp description field. The name in the field is used to describe the ramp within the data selection dialog.

After the colors have been changed, a preview of the new color ramp can be seen by clicking the “Update Image” button. This will change the original image using the altered ramp. The changes can be accepted by clicking the OK button.

After a new ramp has been created it can be saved by right-clicking the image and selecting “Save Color Ramp” from the pop-up menu. The color ramp can be saved in any location, but in order for it to be available in the data selection dialog the ramp needs to be saved in the “/edgedir/color scales” directory.

A custom color ramp can be removed at any time by right-clicking the image and selecting “Use Default Color Ramp” from the pop-up menu. This will remove the custom ramp and revert back to the original default color ramp.
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4.0
Using ODS: Math Functions

Comparisons between two images or sources of data can be done through the use of math functions. These functions can also be used to apply a variety of mathematical functions to data values within an image.
4.1
Difference Images

The math function that is the most likely to be used is the difference function. This function will subtract the values in one image from those in another image. This will effectively show the difference between the two images at each value location.

There are two methods available to difference two images. The first method is to use the data choice dialog to pick two sources of data (see section 3.2). The other method is to select differencing, either by choosing “Subtract Plots” from the Tools menu or by clicking on the difference icon in the toolbar. Once this is done, the cursor will change to a hand with “1” on top of it. At this point, click on one of the images. The cursor will now change to a hand with “2” on it. The second image can now be chosen. After the second image is chosen the cursor will change to a hand with “To” on it. An empty panel or an existing image can now be clicked on in order to select a destination for the difference image.

Difference images are created by subtracting the values of the second image from those of the first image at each pixel (image 1 minus image 2). The settings of the difference image will match those of the first image. For example, suppose the first image is being displayed using the Cartesian projection and is zoomed in on the United States while the second image uses he Mollweide projection and shows the entire Earth. A difference image between these two would use the settings of the first image and will use a Cartesian projection with the same zooming as the first image. This eliminates the need to make certain that the two images show exactly the same thing before the comparison is done.

3.5.2
Other Math Functions

In addition to the difference function, other math functions can be applied to an image. These functions are available under the Tools menu. The functions that apply math calculations between two images are handled in the same manner as the difference function. Once a function is selected, the cursor will change allowing the first image, then the second image, and then the target panel to be selected.

The four math functions that apply a constant value to an image are used in a way that is similar to the functions used for two images. Once selected, a dialog will appear that will ask for the constant value. Once this value is entered the cursor will change to a hand with “1” on it. At this point it is possible to click on the original source image. After this the cursor will change to a hand with “To” on it. The target panel can now be chosen.

3.9
Viewing Individual Profiles

EDGEIS provides the ability to view individual profiles at any location that contains profile data. When a location is selected, the program will search the file for data that is closest in distance to the selected location. The necessary data is then read and a window will appear that contains a graph of every available profile in the file as well as other selected data.
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Figure 9 – Selecting Individual Profiles.

After turning on the profile selection function, the cursor will turn into a hand 

with a profile graph on top of it. At this 

point, clicking anywhere on the horizontal image will result in the generation of a 

graph showing all available profiles from 

the data point that is closest to the selected location.

3.9.1
Selecting A Profile

To view individual profiles, the profile function must be turned on by selecting “View Profile” under the Tools menu or by clicking on the view profile button in the toolbar. This will result in the cursor being changed to a profile cursor (Figure 9) when it is over a horizontal image that was generated from a file containing profile data. If the file from which the image was generated does not contain any profile data, the cursor will change to a red X.

If the cursor is a profile cursor, then you can select a location by clicking on the image. The spot that the hand is pointing to will be the selected location. After the location is selected a window will appear. Depending on the location of the data and the size of the file, there may be a delay ranging from less than a second to several seconds or more while the program searches for the nearest retrieval and reads the appropriate data. If no retrievals were found near the selected location, a warning dialog will appear and the window will go away. It will then be necessary to select another location.

If the current frame contains a single horizontal image, then the profile window will contain a single graph. If the frame contains more than one horizontal image the profile window will still contain a single graph. The data for the graph will come from the file that the image was created from. If there is more than one horizontal image in the current frame, it is possible to create graphs for each image in the frame. This is done by holding down the shift key while selecting a location in one of the images. If this is done, the profile window will contain graphs for each image in the frame using the same location for each one.

3.9.2
The Individual Profile Window

The profile window is a resizable window that contains a graph of the profiles along with selected data associated with the profiles being plotted. The graph area of the profile window contains all of the profiles that are available in the file. Seven different plot types can be used to display the profiles. Four of these plot types are XY plots while three are Skew-T Log-P plots.

Below the graph is a small globe on which is indicated the approximate location of the data. Next to the globe is a legend that shows the color and style of the lines that represent each profile. As the mouse is moved over the graph, the data value of each profile that matches the pressure level is displayed next to the profile description.
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Figure 10 – Individual Profile Window.

The graph shows all profiles that were found for the data point at the selected location.

The graph is customizable and can be changed between Skew-T Log-P and several

varieties of a standard XY plot. The display of the data on the right may also be customized.

The right-hand side of the window contains selected data associated with the data. Most of this information is presented in a table. Depending on the type of data presented, the value may or may not fit within the available space. If there is not enough space to display all of the data, then a scrollbar will appear on the side of the table. The width of each column in the table can be changed by moving the mouse pointer to the table header. When the cursor moves directly over the division between two columns, it will change. At this point it is possible to click and drag the column divider to either the left or right to change the width of the two columns.
3.9.3
Changing The Display Of The Profile Window

The manner in which the data is displayed is very flexible. To change the display of the graph, either click the graph icon in the toolbar or select “Change Graph” from the Display menu. Both of these options will bring up a dialog (Figure 11) containing various display options. There will be one panel in the dialog for each panel in the main profile graph window.

The top of the dialog shows the seven available plot types. Images of each plot show the approximate position along the pressure axis of selected pressures. The plot type is selected by clicking on the image of one of the plot types. When a new plot type is selected, the graph in the profile window will be updated automatically to show how the data looks given the new choice of plot type.
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Figure 11 – Changing The Display Of A Profile Graph

The type of plot used to display individual profiles can be changed using this dialog.

The five plots on the left are XY plots. The three on the right are SkewT LogP.

In most cases, either the left plot type or right plot type will be used.

The other types are included to provide greater flexibility if it is needed.

The five plot types on the left of the dialog are standard XY plots. The P2/7 plot type plots the pressures raised to the 2/7 power. This results in a plot with 100 mb roughly centered vertically. The Linear option plots the pressures on a simple linear scale from 0.1 mb to 1000 mb. This plot type emphasizes the lower atmosphere while greatly de-emphasizing the upper atmosphere. The Logarithmic plot type displays the pressures on a log10 scale which emphasizes the upper atmosphere at the expense of the lower atmosphere. The Special 1 and Special 2 scales are modified linear scales. They both contain three separate linear scales: 0.1 mb to 100 mb, 100 mb to 500 mb, and 500 mb to 1000 mb. Special 1 places 100 mb 25 percent of the way from the top of the graph to the bottom while placing 500 mb at the center point of the scale. Special 2 places 100 mb at 33 percent of the way from the top to the bottom and 500 mb at 66 percent. Both of the scales were designed with the intention of finding a scale that showed both the upper and lower parts of the atmosphere without overemphasizing one or the other.

The three plot types on the right side of the dialog are skew-temperature log-pressure scales. Each scale plots the profile data using standard skew-t log-p calculations. The difference between the three scales is the upper pressure level allowed. The 100 mb scale only plots the data up to 100 mb while the 10 mb scale only goes up to 10 mb. Any profile data above these levels are ignored.

When a standard XY plot is being used, it is possible to display grid lines at each major pressure and data level. This is done by selecting the “Show Grid Lines” option under the Display menu. For all types of graphs, the “Show Data Points” menu item can be selected. This will result in circles being drawn showing the location of each point that makes up the profiles. When this option is turned off only the profile lines are displayed.

Underneath the plot types in the dialog are two checkboxes: “Show Grid Lines” and “Show Data Points”. The grid line box turns the display of grid lines on and off (this option is disabled when a Skew-T Log-P plot is selected). The data point box turns the display of data points on or off. When this is selected, the graph will show the actual data points that we used to create the profiles.

Beneath the checkboxes is a list that will contain one or more groups of auxiliary data. Depending on the source of data there may be several groups of data available. The data from the chosen group is displayed in the table to the right of the graph.

At the bottom of the dialog are checkboxes representing each of the available profiles. The profiles that are selected will be displayed in the graph.

The “Zoom In” and “Zoom Out” menu items and toolbar buttons control the amount of zooming within the profile graph. Every time one of these is selected, each graph will zoom in or out by a factor of 2. It is possible to zoom in on a graph up to three times. When the amount of zooming is greater than 1, scrollbars will appear on the right-hand side and bottom of the graph. These allow the graph to be moved around to focus on a particular area. Another way to move around when the graph is zoomed is to move the mouse over the graph and then click and drag the mouse. The image will pan in response to the dragging of the mouse.

3.10
Viewing Vertical Cross Sections

Vertical cross-sections (slices) of the atmosphere can be created between any two points on the Earth’s surface. When a cross-section is created, the line representing the cross-section is divided into 100 points. The file is then searched to find data points that are closest to each of the 100 points along the line. Profile data is read from each of the nearby data points and then a graphical representation of the profile data is displayed.

3.10.1
Selecting A Vertical Cross-Section

To view vertical cross-sections, the slice function must first be turned on by selecting “View Slice” under the Tools menu or by clicking on the view slice button in the toolbar. Once this is done the cursor will change to a slice cursor when it is over a horizontal image that was generated from a file containing profile data. If the file from which the image was generated does not contain any profile data, the cursor will change to a red X.

To draw the line at which the vertical cross-section should be made, click on the image at the start of the line and, while keeping the mouse button pressed, drag the mouse to the end point of the line. As this is done a rubber band line will appear on top of the image. The final position of this line will be the location of the slice.
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Figure 12 – Creating A Slice.

Creating a vertical cross-section 

is done by drawing a line across 

a horizontal image at the location 

of interest. The values used to create the cross-section will come from the data points that are 

closest to the line.

If the current frame contains more than one image, then a cross-section will only be created for the image that the line was drawn on top of. However, if the shift key is held down while the line is being drawn, then the vertical cross-section window will contain a cross-section corresponding to each image in the frame. Each cross-section will be created using the same line.

3.10.2
The Vertical Cross-Section Window

The vertical cross-section window shows an image of the Earth’s atmosphere (Figure 13). The Y axis of the image corresponds to pressure levels. The X axis of the image matches up with the 100 points along the line. The image may also contain white and brown lines depending on the location of the slice. The white line shows cloud top pressures, if present and available. The brown line shows the pressure at the surface of the Earth, resulting in an approximation of the surface elevation. Any data below the surface is not displayed.
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Figure 13 – Vertical Cross-Section Window.

The image on the left shows the cross-section of the atmosphere along the selected line.

The right side of the window contains information about the data and a map showing

the location of the cross-section. The arrow shows the direction that the cross-section

is being viewed from.

To the right of the cross-section is information about the vertical slice. The type of data used to create the slice is displayed along with the number of pressure levels used. The starting and ending times of the actual data are displayed along with the endpoints of the line.

Also to the right of the slice image is a small map that shows where the cross-section is located. The gray line across the map shows the area of the cross-section. The arrow shows the direction that the cross-section is being viewed from. When the slice line is drawn, the start of the line will be on the left of the slice while the endpoint of the line will be on the right side of the slice.

3.10.3
Changing The Display Of The Vertical Cross-Section Window

When a vertical cross-section is displayed for the first time the resulting slice image will usually show unsmoothed temperature data. The type of data displayed and the manner in which it is displayed can be changed by selecting the “Change Panel Options” menu item which is located under the Options menu. This will bring up a dialog that will allow the settings to be changed (Figure 14).
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Figure 14 – Changing The Slice.

The vertical cross-section contains data for each available profile. The profile data being displayed is changed by selecting a new profile from the top list.

Smoothing and contouring can also be applied in the same manner that they can be applied to a horizontal image. The color scale, data range and pressure limits are also adjustable.

If the data source contains values for cloud top pressures, the display of these can be turned on or off by selecting or deselecting the box.

The first item in the dialog contains a list of every profile that is available in the file. The type of data can be changed by selecting a different profile in this list.

The image can be smoothed by changing the setting in the smoothing list. The smoothing is done using area averaging, so the larger the selected value the more the image will be smoothed.

An image will typically contain 240 different colors. The number of colors can be reduced by changing the value in the contour field. This will result in a contoured image similar to the one shown in figure 13.

The color scale defaults to a standard rainbow (purple to blue to green to yellow to orange to red) scale. This can be changed to black and white scales that either go from black to white or from white to black.

The minimum and maximum data values of the selected profile are listed in the minimum and maximum fields. If these values are changed, then the range of the color scale will be adjusted accordingly.

After the data value fields are two drop-down lists that represent the minimum and maximum pressure levels. The selected minimum pressure will be the pressure that is displayed at the top of the slice image. The selected maximum pressure will be the pressure that is displayed at the bottom of the slice image. These options can be used to restrict the display of the slice in order to remove pressure levels at the top or bottom of the image.

If either pressure level is set to a value that is not available in the data, then the largest or smallest pressure from the data will be used as the limit. For example, if the data only goes up to 200 mb (such as water vapor) and the minimum pressure is set to 10 mb, then the minimum setting will be ignored and the 200 mb data will be displayed at the top of the slice.

The last option in the dialog will turn the display of the cloud top pressures, if available, either on or off. When cloud top pressures are displayed, white lines will appear on top of the slice image showing the locations of cloud tops.


4.0
Additional Features

EDGEIS contains a variety of features that apply to the entire program. Some of these features provide useful functionality such as printing and saving images. Others exist in order to provide some flexibility in the display of data and in the manner in which the program runs.

4.1
Printing

EDGEIS provides the ability to print any image. This includes horizontal images, vertical cross-sections and individual profile graphs. These images can be printed to any printer that the computer has access to.

The orientation of the page can be changed between landscape and portrait using the page setup option. This is accessed by selecting “Page Setup” under the File menu and will bring up a dialog that allows you change the orientation of the page. Depending on the operating system being used, this dialog may also allow you to select a printer, change the page margins, change the paper size, and scale the image.

A preview of the printed image can be viewed by selecting “Print Preview” under the File menu. A window will be created that shows what the printed image should look like.

The actual printing of an image is done by selecting “Print” from the File menu. This will bring up a print dialog that allows you to make final changes to the settings before printing the image. Some operating systems provide the ability to print the images as a PDF file. If this option is available, there will be a button at the bottom of the print dialog (Figure 15) that saves the image as a PDF. Clicking this button will result in a save file dialog prompting you to name the file.


[image: image35.wmf]
Figure 15 – Print Dialog.

This image shows a typical print dialog. The actual dialog will vary depending 

on the operating system being used.

4.2
Saving Images

All horizontal images, vertical cross-sections and individual profile graphs can be saved as an image file (currently in jpeg format only). This is done by selecting “Save As Image” from the File menu. A dialog will appear (Figure 16) that lets you choose the size of the image.


Figure 16 – Image Size Dialog.

Images can be saved at any size. The current button will set the image size to the size of the image on the screen. The other buttons can be used to quickly select common sizes. Any 

other size can be used by changing the values 

in the text fields.

If the “Preserve Aspect Ratio” box is selected, then the resulting image will use the same width to height ratio as the image has on the screen.

The initial size of the image will be the same size as the image on the computer screen. The size can be changed by selecting one of the pre-defined size buttons or by entering new values in the “New Size” fields. If “Preserve Aspect Ratio” is selected, then the size of the image will be automatically adjusted to force it to have the same aspect ratio (width divided by height) as the current image.

There are no limits to the size of the resulting image. Please be advised, however, that large size values (typically larger than 2000 x 1000) will result in very large images. It is also possible to enter very small values. But this could result in an image with text that is difficult to read or garbled. EDGEIS tries to fit all information into the available space. But if the amount of available space becomes too small then nothing can be done to make everything fit and be legible at the same time.

After the size of the image is selected, a save file dialog will appear. After the location and name of the file is entered, the image is saved.


4.3
Setting Preferences

Various preference settings can be changed by selecting “Preferences” under the Edit menu. This will bring up the preference dialog (Figure 17). Different types of preferences can be selected by clicking one of the icons along the left side of the dialog. When one of the icons is selected, the options on the right side of the dialog will change.

The “Data Labels” preferences affect the display of certain labels used throughout EDGEIS. Most temperature values can be displayed as Kelvin, Celsius or Fahrenheit. The unit used can be changed by selecting one of the options in the dialog. Similarly, pressure values can be displayed as mb or hpa by changing the options in the dialog. Finally, the formats of dates can be adjusted by picking one of the available options.


Figure 17 – Data Label Prefs.

The buttons on the left side of the dialog can be clicked to changed between the available preference panels.

The data label preferences affect the manner in which certain data labels are displayed.

The “Appearance” preference option (Figure 18) affects the look and feel of the windows and controls of EDGEIS. Although this feature is generally cosmetic, there may be times when adjusting the look and feel may improve the layout of windows and controls. There will usually be three options available. The Metal look and feel is a generic cross-platform setting. Selecting CDE/Motif will create windows that appear similar to those used by XWindows. The third option will usually be the same look and feel as the operating system that EDGEIS is being run on.


Figure 18 – Appearance Prefs.

The appearance preferences affect the overall look and feel of the program windows and controls.


The “Fonts” preference panel (Figure 19) provides the ability to change the font, font style, and minimum font size of some of the labels used by EDGEIS. A list of every font that is available on the computer is provided from which a desired font can be picked. The style of the font can also be selected. The minimum font size is the smallest size that will be used when drawing labels. When drawing labels, EDGEIS will try to use as large a font size as possible while still allowing all of the text to fit. But the program will stop reducing the font size when it reaches the value set here.



Figure 19 – Font Preferences.

The font, font style and minimum font size can be adjusted by changing these controls.

The list of fonts will contain every font available on the computer.
The “Data Servers” preference option (Figure 20) can be used to change the list of available data servers from which data can be obtained. EDGEIS starts with a default set of servers but it may be desirable to add new servers to the list or to prevent access to a server. Although it is possible to add the address of any computer to the list of servers, only computers running a valid data server will be usable. 

The preference panel contains a table of data servers. The first column contains a checkbox. If the box is selected the data server in the row will be added to the list of servers. If the box is not selected the server will be skipped. The second column contains a descriptive name for the data server. The third column contains the IP address of the server while the fourth column contains the port number.

The preference panel also contains the checkbox “Allow Network Connection”. When this box is selected EDGEIS will contact the selected data servers. When the box is not selected, the data servers will not be contacted and it will not be possible to generate images using data from the data servers. This may be useful when EDGEIS is being run from a computer that does not have a dedicated Internet connection. When the network connection is not selected, EDGEIS will not attempt to establish an Internet connection in order to obtain initial information from the data servers.

The “Profiles” preference option (Figure 21) can be used to change the color, thickness and style of lines used to represent profiles in the profile graph windows. The preference panel contains selection options for 16 profiles. When profiles are displayed in the profile graph, they are displayed in a certain order that may vary depending on the source of the data. But in general, the order that they are listed in the legend of the profile window will be the order that they are listed in the preference panel. For example, most of the time the profiles will be listed in the order: retrieved temperature, retrieved dew point, first guess temperature and first guess dew point. This should match the order in the preference panel.

For each profile, it is possible to change the color, line thickness and line style. This is done by changing the selection in each of the 3 columns of drop-down lists. This color list show a set of pre-defined colors. This thickness list allows the thickness of each line to be adjusted from 1 pixel (thin) up to 9 pixels (thick). The style of the line can be set to either solid or dashed. When any of the options are selected, the profiles in any open profile windows will be immediately updated. This provides quick feedback when deciding which options to use.

4.4
Changing Labels In An Image

When horizontal images are created the title labels are created from data in the file. The labels and be changed by selecting “Change Labels” under the Tools menu. This will bring up a dialog that allows the labels to be changed (Figure 22)


[image: image36.wmf]
Figure 22 – Title Label Dialog.

Each image can contain up to 9 title labels. Each label can be changed by

entering new values in the text fields in this dialog.

Each image has room for as many as nine labels (3 rows and 3 columns). Each grid in the dialog represents one of the labels. If a grid does not contain any text then the label will be not displayed. The length of each label is unlimited. However, they should be kept reasonably short. EDGEIS will try to arrange the labels to make each one fit, but if the labels are too long then this will not be possible and the labels will overlap or not fall within the available area.

4.5
Using The Shortcut Accessory

All file dialogs used by EDGEIS include a shortcut accessory. This is an addition to the dialog that allows frequently used files and directories to be accessed quickly. The list of files and directories is customizable.

The actual location and look of the shortcut accessory will vary depending on the operating system but will look similar to figure 23. The file dialog will contain all of the controls that a normal file dialog contains.

Files and directories are added to the list of shortcuts by selecting one in the file list and then clicking the add button. This will add the file or directory to the end of the shortcut list using its fully qualified name. The shortcut can be removed by highlighting it in the shortcut list and clicking the delete button.

The shortcut accessory also provides the ability to use an alias for any shortcut or directory. When an alias is used, it will appear in the shortcut list in place of the full file or directory name. To distinguish aliases from regular file names, all aliases appear in the shortcut list surrounded by brackets. An alias is assigned by highlighting the shortcut in the shortcut list, then typing the alias name in the text field next to the set button. Once the set button is clicked, the alias will be assigned.

Another feature provided by the shortcut accessory is the use of color to differentiate shortcuts. The color used by a shortcut is set by adding “color#” in front of the alias name. For example, setting the alias as “blue#Test File” will create an alias called “Test File” that will be displayed in blue. The color can be removed by retyping the alias name without a color in front of it. The possible colors are: blue, red, yellow, green, orange, cyan, magenta, pink, and teal.

Other colors can also be used by typing a 6 digit hexadecimal string in front of the alias. The first two digits represent the red component of the color, the next two digits represent the green, while the last two represent the blue. For example, setting the alias as “FF8000:Test File” will result in an alias that is displayed using orange (red=255, green=128, blue = 0). Although this method is a little more difficult to use, it does provide for the use of nearly all colors.


[image: image37.jpg][ Y¥e¥e Open (/Users/mpettey/Develop/data/edgeis)

Name Date Modified

Type: Edge 6 bitlprod.dat 7/26/02
File Date: 9/14/2003 17:33 bltlwmrdat  7/26/02

Data Date: 9/14/2003 19:08 Bt i
- Shortcuts. lld16a4c.dat 7/26/02
ld16a4h.dat 7/26/02

ld16aamdat  7/26/02
ld16adr.dat 7/26/02
mif0612.dat 7/26/02
New Format 7/30/03
[7 other Groups 6/22/03
[ posse.a? 9/14/03
S posse.goes 9/11/03
= — [ ] 9/14/03

" posse_sepld_1... 9/14/03

Format: [ All

(o) @O |





Figure 23 – File Open Dialog With The Shortcut Accessory.

File dialogs in EDGEIS contain a shortcut accessory, which is an additional control located next to the list of files.

The shortcut accessory contains a list of shortcuts to frequently used files or directories. This allows for files and directories to be accessed quickly without the need to traverse the computer’s directory structure. The shortcuts in the list can be added and removed at any time. The shortcut accessory also displays information about the selected file.

5.0
EDGEIS And POSSE Files

Beginning with EDGEIS 6.0 a new file format is used. This format is similar to the format used by previous versions of EDGEIS in that the parameters are grouped into blocks of data. The file contains a header that describes the data in the file. The header is then followed by multiple blocks of data, each of which contains data for one parameter.

The new format differs from the old format in the following significant ways:

· The new files do not have to be byte-swapped in order to make them work on PCs.

· The data in the old files were grouped in blocks of 256 bytes each. There would be a 256 byte block for the first parameter, then a 256 byte block for the second parameter, an so on. After the 256 byte block for the last parameter, there would be another 256 byte block for each parameter. With the new format, the data for each parameter is stored in one large block. The size of each block varies depending on the amount of data available.

· The old format required separate files for sequential and gridded data .The new format still requires separate files for sequential and gridded data, although beginning with EDGEIS 6.0 it is possible to display sequential data in a gridded format. Depending on the application this may eliminate the need to create a sequential file and a gridded file, both of which contain the same data.

· Using the old format, it was necessary to create separate files for data that used the Cartesian projection and data that used the Polar projection. Beginning with EDGEIS 6.0, there is no longer a need to create separate files for each projection. The data are stored along with corresponding latitudes and longitudes. These are used to display the data in any of the available projections. This applies to both sequential and gridded data.

· The new format contains special data indicators for selected parameters. These are used to determine what type of data the parameter represents.

· The old file format restricted the number of parameters in each file. With the new format, the number of parameters is unlimited.

A typical file using the new format may be arranged as follows:

	Header record

	Latitude Data Block

	Longitude Data Block

	Year (YYYY) Data Block

	Month and Day (MMDD) Data Block

	Hour (HH) Data Block

	Minute and Second (MMSS) Data Block

	1st Parameter Data Block

	2nd Parameter Data Block

	.

.

.

	Nth Parameter Data Block


In the file, the data blocks follow the header record. The order of the data blocks is not important. Although it is customary to have the header record followed by the block of latitude data, followed by the block of longitudes, followed by the date and time data blocks, followed by the parameters, it is not mandatory to order the blocks in this way. The use of data indicators allows the blocks to be arranged in any order. One thing to note, however, is that the order of the parameters affects the order in which the available parameters appear within the data selection dialog of EDGEIS. The order of the parameters in the file is the order in which they will appear in the selection dialog.

For sequential data, each file must contain a block of latitude data and a block of longitude data. These are mandatory since the latitude and longitudes will be matched with data from the parameter that is being displayed. If the latitudes and longitudes are not present, or if they do not match with the other data in the file, then the resulting image will be incorrect. For latitudes, the data indicator in the block header should be set to 20000. For longitudes it should be set to 20001. When looking for these data, EDGEIS will search for those indicators.

Each file may also contain blocks of data for a 4-digit year (data indicator = 20002), month and day (mmdd, indicator = 20003), hour (indicator = 20004), minute and second (mmss, indicator = 20005), and orbital node (indicator = 20006). These parameters are not mandatory but can be used to restrict the data that is displayed. For example, the file may contain data from 0Z to 23Z but if the dates and times are available, EDGEIS can be told to only display data from 6Z to 18Z.

One of the most significant features that was introduced with EDGEIS 6.0 is the ability to display individual sounding profiles and vertical cross-sections. These features would not be possible if it were not for data indicators to tell EDGEIS which data blocks contain profile data. For profile data, such as temperatures and water vapor, there is a range of data indicators that are reserved to allow the data to be grouped into separate profiles. All temperatures profiles use data indicators that range from 10000 to 10499. Water vapor profiles range from 10500 to 10999. Although the specific data indicator for a group of profile data does not matter in general, it is suggested that certain indicators be used with certain data. For example, retrieved temperature data should use 10000 while first guess temperature data should use 10001. All blocks that contain data for the same profile should use the same data indicator. This tells EDGEIS that the separate blocks contain data for the same profile. With profile data it is important that a pressure level be supplied in the data block header. Without this value, EDGEIS will not know where the data fits into the profile and will not be able to plot it.

One of the primary benefits of the new format is that it is also used by POSSE. This reduces the amount of overhead required to create the files since the same data capture programs can be used to capture data for both programs.

The numerical data are stored in the header record as either 2-byte or 4-byte integers. Floating point values are multiplied by the scaling factor before being written to the file. Character strings are stored as a series of ASCII byte values.

Appendix A — Edge / POSSE File Format

Note:
Unlike EDGEIS 5.x files, EDGEIS 6.x files do not need to be byte swapped regardless of 

the platform on which EDGEIS is running.

Header Record

	Byte
	Word
	Data Type
	# of Values
	Length
	Scale
	Description

	0
	1
	Int
	1
	4
	
	File type 

(69687169 = “EDGE”)

	4
	2
	Float
	1
	4
	10
	File version number

(i.e., “10” = 1.0)

	8
	3
	Int
	1
	4
	
	Data type

(0=sequential, 1=gridded)

	12
	4
	Int
	1
	4
	
	Length of header record (bytes)

	16
	5
	Int
	1
	4
	
	Number of data blocks

	20
	6
	Int
	1
	4
	
	Length of each data block

	24
	7
	Int
	1
	4
	
	Number of values in each block

	28
	8
	Int
	1
	4
	
	File initialization date

(YYYYMMDD)

	32
	9
	Int
	1
	4
	
	Date of last file update

(YYYYMMDD)

	36
	10
	Int
	1
	4
	
	Date of oldest data in the file

(YYYYMMDD)

	40
	11
	Int
	1
	4
	
	Time of oldest data in the file

(HHMMSS)

	44
	12
	Int
	1
	4
	
	Date of newest data in the file

(YYYYMMDD)

	48
	13
	Int
	1
	4
	
	Time of newest data in the file

(HHMMSS)

	52
	14
	Float
	1
	4
	100
	Left longitude (-180 to +180)

	56
	15
	Float
	1
	4
	100
	Right longitude (-180 to +180)

	60
	16
	Float
	1
	4
	100
	Top latitude (-90 to +90)

	64
	17
	Float
	1
	4
	100
	Bottom latitude (-90 to +90)

	68
	18
	Float
	1
	4
	
	Index of last data written

	72
	19
	Float
	1
	4
	10
	Horizontal grid size in degrees

(if data is gridded)

	76
	20
	Float
	1
	4
	10
	Vertical grid size in degrees

(if data is gridded)

	80
	21
	Char
	1
	36
	
	System description

(“ATOVS NOAA-16 (A2)”)


Data Record

	Byte
	Word
	Data Type
	# of Values
	Length
	Scale
	Description

	0
	1
	Char
	1
	36
	
	Parameter description

	36
	18
	Int
	1
	2
	
	Parameter number1

	38
	19
	Int
	1
	2
	
	Visibility flag

(0=don’t show, 1=show)

	40
	20
	Float
	1
	2
	10
	Spot size in km

(if data is sequential)

	42
	21
	Int
	1
	2
	
	Scaling factor

	44
	22
	Float
	1
	4
	100
	Default minimum

	48
	24
	Float
	1
	4
	100
	Default maximum

	52
	26
	Float
	1
	4
	100
	Center point

	56
	28
	Float
	1
	2
	10
	Pressure (if applicable)

	58
	29
	Int
	1
	2
	
	Alternate label flag (0=none, 1=temperature, 2=pressure)

	60
	30
	Char
	1
	12
	
	Unit

	72
	36
	Int
	1
	2
	
	Data type (0=continuous, 1=not continuous)

	74
	37
	Float
	10
	4
	100
	Special values

(-32768 if not used)

	114
	57
	Char
	10
	12
	
	Special descriptions

	234
	117
	Int
	1
	2
	
	Scale number2

	236
	118
	Int
	256
	2
	
	Color scale (red values)

	748
	374
	Int
	256
	2
	
	Color scale (green values)

	1260
	630
	Int
	256
	2
	
	Color scale (blue values)

	1772
	886
	Int
	1
	2
	
	Offset within master file

(used by POSSE only)

	1774
	887
	Int
	13
	2
	
	Spare

	1800
	900
	Float
	num vals
	2
	
	Data


Appendix B — EDGEIS 5.x File Format

EDGEIS 5.x files can contain data in either gridded or sequential format. The layouts of the file for gridded and  sequential data are:

Note:
All EDGEIS 5.x files contain swapped bytes to make the least significant byte first. 

EDGEIS 6.x automatically compensates for this regardless of the platform on which 

it is running.

Header Record

	Byte
	Word
	Data Type
	# of Values
	Length
	Scale
	Description

	0
	0
	Int
	1
	2
	
	Grid type (1=cartesian, 2=polar)

	2
	1
	Int
	1
	2
	
	Data type index1

	4
	2
	Int
	1
	2
	
	Starting year

	6
	3
	Int
	1
	2
	
	Starting month

	8
	4
	Int
	1
	2
	
	Starting day

	10
	5
	Int
	1
	2
	
	Starting hour

	12
	6
	Int
	1
	2
	
	Ending year

	14
	7
	Int
	1
	2
	
	Ending month

	16
	8
	Int
	1
	2
	
	Ending day

	18
	9
	Int
	1
	2
	
	Ending hour

	20
	10
	Int
	1
	2
	
	Number of parameters in the file

	22
	11
	Int
	1
	2
	100
	Version number of the file header format

	24
	12
	Int
	4
	2
	
	Signature: “EDGEGrid”

	32
	16
	Int
	1
	2
	
	Number of words per row

	34
	17
	Int
	1
	2
	
	Number of rows in the grid2

	36
	18
	Int
	1
	2
	100
	Maximum latitude of the grid (-90 to +90)

	38
	19
	Int
	1
	2
	100
	Maximum longitude of the grid (-180 to +180)

	40
	20
	Int
	1
	2
	100
	Minimum latitude of the grid (-90 to +90)

	42
	21
	Int
	1
	2
	100
	Minimum longitude of the grid (-180 to +180)

	44
	22
	Int
	1
	2
	1000
	Increment between grid points (latitude)

	46
	23
	Int
	1
	2
	1000
	Increment between grid points (longitude)

	48
	24
	Int
	1
	2
	
	Y coordinate or row number of Pole (polar only)

	50
	25
	Int
	1
	2
	
	X coordinate of column number of Pole (polar only)

	52
	26
	Int
	1
	2
	100
	Column spacing at standard latitude (polar only)

	54
	27
	Int
	1
	2
	100
	Longitude parallel to columns (polar only)

	56
	28
	Int
	27
	2
	
	File description (up to 54 characters) 3

	110
	55
	Int
	27
	2
	
	Satellite system description (up to 54 characters) 4

	164
	82
	Int
	46
	2
	
	Spare


1 The data type index is used to indicate what type of data the file contains. It is compared to the value in the external table which defines the list of available data types. The primary use for this variable is to make sure that only files which are compatible with the selected data type will be used. For example: If the datatype.prm file contains the value 3 for the data type index, only data files that have a 3 in this word will be considered valid files. The special value 99 can be used in the datatype.prm file to indicate that any data file is to be considered valid.

2 Polar files will actually have twice as many rows because there is a grid for the north and another grid for the south.

3 The file description is stored as a sequence of ASCII values. This value is not used by EDGEIS 6.x.

4 The satellite system description is stored as a sequence of ASCII values. This value is displayed in the title panel of each EDGEIS image.

Data Block Header

	Byte
	Word
	Data 

Type
	# of 

Values
	Length
	Scale
	Description

	0
	0
	Int
	1
	2
	
	Parameter number

	2
	1
	Int
	1
	2
	
	Scaling factor

	
	2
	Int
	1
	2
	
	Description flag

	6
	3
	Int
	1
	2
	
	Data parameter description

	8
	4
	Int
	1
	2
	
	Default map color pen number

	10
	5
	Int
	1
	2
	
	Default scaling method

	12
	6
	Int
	1
	2
	
	Default minimum to use for scaling data

	14
	7
	Int
	1
	2
	
	Default maximum to use for scaling data

	16
	8
	Int
	1
	2
	
	True minimum value contained in the grid

	18
	9
	Int
	1
	2
	
	Log minimum value contained in the grid

	20
	10
	Int
	1
	2
	
	True maximum value contained in the grid

	22
	11
	Int
	1
	2
	
	Switch for missing data fill value

	24
	12
	Int
	4
	2
	
	Missing data fill value

	32
	16
	Int
	1
	2
	
	Switch for auxiliary fill value

	34
	17
	Int
	1
	2
	
	Auxiliary fill value

	36
	18
	Int
	1
	2
	
	Color lookup table index

	38
	19
	Int
	1
	2
	
	Label file name

	40
	20
	Int
	1
	2
	
	Scale type

	42
	21
	Int
	1
	2
	
	Center value

	44
	22
	Int
	1
	2
	100
	Radius of spot size (degrees)

	164
	82
	Int
	46
	2
	
	Spare


Appendix C — Pre-Defined Data Indicators

5001
Forecast Time Difference

5002
Forecast Increment

5003
Forecast Year

5004
Forecast Month/Day

10000
Retrieved Temperature

10001
First Guess Temperature

10002
AVN Forecast Temperature

10003
AVN Analysis Temperature

10010
AMSU-A Brightness Temperature (not limb corrected)

10011
AMSU-A Brightness Temperature (limb corrected)

10012
HIRS Brightness Temperature (not limb corrected)

10013
HIRS Brightness Temperature (limb corrected)

10049
Generic Temperature Profile

10500
Retrieved Water Vapor

10501
First Guess Water Vapor

10502
AVN Forecast Water Vapor

10503
AVN Analysis Water Vapor

10999
Generic Water Vapor Profile

20000
Latitude

20001
Longitude

20002
Year (yyyy)

20003
Month/Day (mmdd)

20004
Hour (hh)

20005
Minute/Second (mmss)

20006
Orbital Node
Appendix D — Pre-Defined Color Ramps

	Ramp Number
	Ramp Appearance
	

	0
	
	Use the scale provided in the data block header

	1
	[image: image38.png]



	Rainbow

	2
	[image: image39.png]



	Cloud (white to blue)

	3
	[image: image40.png]



	American

	4
	[image: image41.png]



	Precipitation

	5
	[image: image42.png]



	10 Color

	6
	[image: image43.png]



	Terrain

	7
	[image: image44.png]



	Cloud Mask

	8
	[image: image45.png]



	Grayscale (white to black)

	9
	[image: image46.png]



	Grayscale (black to white)

	10
	[image: image47.png]



	Cloud (blue to white)


Appendix E — Map Projections

Cartesian


The Cartesian projection is the default projection used by ODS. The longitude of the center of the map is set to 0 degrees by default. This can be changed by setting the value of the center longitude to another longitude.

Polar Stereographic

The Polar projection displays either the northern hemisphere or the southern hemisphere. When this projection is chosen, it is possible to set the value of the latitude extent, which limits the amount of the hemisphere that is showing. For example, if the latitude extent is set to 30 degrees, then the resulting map will show the hemisphere from the pole to 30 degrees.

Dual Polar


The Dual Polar projection is similar to the Polar projection. The difference is that this projection shows both hemispheres at the same time. As with the Polar projection, the latitude extent can be used to limit the amount of the hemisphere that is visible.

Orthographic


The Orthographic projection simulates a point-of-view perspective. Using this projection is like looking at a globe above any point. The center latitude and longitude values are used to select the spot on the Earth that the image should be centered on.

Mollweide


The Mollweide projection shows an elongated view of the Earth. By default, the image is centered at 0 degrees longitude, but this can be changed by setting the center longitude to another value.

Appendix F — EDGEIS Versions

Version 6.4

· The file separator was changed from a platform specific character to a Java neutral character.

· The main window toolbar has been moved from the top of the window to the left side of the window. This should provide more vertical space for the images.

· Changed existing preference dialog setups to conform with other EDGE programs.

· Added the ProfilePrefsDialog.

· Solved problem of lost links to ProfileWindows and SliceWindows.

· Changes to unit labels are now sent to all open ProfileWindows and SliceWindows.

Running ODS On A Macintosh





If you want to run ODS on a Macintosh, you must use Mac OS X. Systems 9.x and earlier will not be able to run ODS. If you are running OS X then you do not need to install Java because it will already be installed and set up by default. Should you wish to update your version of Java, you may do so by using Software Update or by visiting Apple’s Java page at http://www.apple.com/java/ 





Frame Management In Earlier Versions Of ODS





Versions of ODS prior to 6.0 used a predetermined number of frames. The actual number of frames was set either during ODS installation or using a manual setup program. Depending on the number of frames, a certain amount of the computer’s memory would be reserved for use by ODS. When the program was run, each frame was read from disk and stored in memory. This allowed for fast switching between frames. The primary drawback of this method involved the manner in which the computer’s memory was reserved. In particular, changes had to be made to the config.sys file in order to set aside the specific amount of extended memory that would be used when the program was run. This worked fine initially, but with each successive version of Windows, it became more difficult to make this work.





Beginning with ODS 6.0, the method of managing frames was completely changed. Instead of reading each frame into memory, the frames are kept on disk. Only the current frame and previous frame, if available, are saved in memory. Although this results in a small time delay when switching frames, it eliminates all of the problems associated with keeping the frames in memory.





In ODS 6.0 and higher, there is no predetermined number of frames. The program begins with one empty frame when it is run for the first time. The user may then add and remove frames at will. The maximum number of frames is only limited by the amount of storage space on the local computer.








Using Contextual Menus (Right-Clicking)





��



By right-clicking on any panel or image, a contextual menu will appear. If any of the menu items are selected, then the chosen function will apply only to the panel that was clicked on. 





For example, if you have a frame that contains 4 quadrants, pressing the “Select Data” button will bring up a data selection dialog that applies to all 4 panels in the frame. But right-clicking on one of the panels and choosing “Select Data” will bring up a data selection dialog that only applies to the selected panel.


�
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256 Color Values





ODS uses 256 colors for each ramp. 240 of the colors (colors 0 to 239) are used with continuous data such as temperature values. 10 colors (240 to 249) are used for special non-continuous data such as clear areas or terrain values. Colors 250 and 251 are used for data that exceed the range of the color scale, either low (250) or high (251). Color 252 is not used at this time. Color 253 is the color used to draw coastlines and political boundaries. Color 254 is the background color (normally set to black) and Color 255 (normally set to white) is the foreground color used for text.





Searching For Matching Profiles





It is not necessary to click directly on top of a data footprint when selecting a location. ODS converts the x/y coordinate that was clicked on into latitude/longitude values. It will then search for data that is closest is distance to this latitude and longitude. The advantage of this is that selecting a location is easier since it is not necessary to be highly precise when clicking on the image. The disadvantage of this method is that it is possible that the profile you end up with may not be the one you wanted. This is especially true if there is a large amount of overlapping data.





Applying Zooming, Profile Selection and Slice Selection To All Images In A Frame





If a frame contains more than one image, there will likely be times when you want to apply zooming to each image in the frame instead of just one. This can easily be done by pressing and holding the Shift key while clicking on any on of the images. If this is done, each image will be recreated and will use the selected image’s zoom factor to determine the amount of smoothing. As a result, each image will show the same amount of zooming and will also show the same Earth location.





Pressing and holding the Shift key also works when selecting individual profiles and vertical cross-sections. In these cases, holding down the Shift key and making the appropriate selection will result in profiles and vertical cross-sections from each image in the frame.





Selecting Image Sizes





The ability to change the size of saved images was added because it is often desirable to create an image that is a specific size. This often happens when creating images for use in presentations or papers. While it is possible to create an image at a default size and then resize the image at a later time, this can produce images that are pixilated or missing data. It is usually a better idea to create an image at the necessary size from within ODS. The text and thin lines within the image will almost always look better.





Changing Font Sizes





When the area available for the text is large, the minimum font size setting does not matter. When the available space is small, however, this value will make a difference. When there is little room available to fit the text, the program will shrink the text as much as possible to try to make it fit. If the minimum font size is set too low, then the text may be too small to read. But if the value is set too high, then there may not be enough room and the text will be drawn using the set value resulting in text that may overlap or not fit within the window. The extent to which this is a problem depends on the operating system, computer monitor, and the resolution of the computer screen. If you experience problems with some of the text, then adjusting the font settings may help.
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